
WinCCU Service Pack 6.06 
 
Welcome to WinCCU Version 6.06.  This version includes bug fixes and enhancements 
which have been asked for from our previous version (6.05). The following are some of 
the highlights. 
 

1. Corrected crash with NEXT METER button when viewing trends from database 
2. Corrected turbine meter issues with FlowCal CFX output 
3. Added tap location missing in characteristic report 
4. Updated events to include new event codes from flow computer 
5. Corrected file extension on report output to txt and xls 
6. Corrected scrolling issue with shell grid update after an operation 
7. Groups now sorted in the scheduler setup selection 
8. Added a checkbox to collect all trend files in trend collect 
9. Corrected issue with remote configure on trends and valve control 
10. Corrected issue with NEXT METER on tabular trend data view 
11. Corrected issue with last used trend files selected on browse for trend file 
12. Corrected issue with intermittent crash on selecting a filter group in the shell 
13. Added feature to save last tree view state in the shell 
14. Corrected issue generating error message when deleting a group 
15. Inhibit launching ID manager when shell column header is double clicked 
16. Added feature to reflect meter list changes outside the WinCCU application 
17. Corrected situation in which the ID versions table was not updated correctly 
18. Make the default state for a Com Type packet protocol 
19. Corrected problem with multiple runs of EMCAPS output 
20. Corrected ID manager problem creating BTU/X IDs 
21. Corrected ID manager crash on groups with duplicate IDs 
22. Corrected problem with ascii file output from LTDB (must reupdate database) 
23. Corrected problem with missing data report not accounting for contract hour 
24. Corrected problem with scheduled trend collect getting wrong ini entries 
25. Added row numbering to shell 
26. Changed communication in progress boxes to minimize to task bar for 

scheduled collects 
 
WinCCU Service Pack 6.05 
 
Welcome to WinCCU Version 6.05.  This version includes bug fixes and enhancements 
to version 6.04. The following are some of the highlights. 
 

1. Corrected problem with etfdata asciifile output when selecting date range of 
last # full days. 

2. Corrected problem with saving edits to configurable reports. 
3. Corrected problem with WinCCU Version check utility. 
4. Corrected problem with characteristics report not correctly reporting the last 

changed dates for changed parameters. 



5. Added enhancement to characteristics reports to add column headers 
(parameter, value, date modified) to report. 

6. Corrected problem with Log Period report reporting incorrect 
integral/extension value. 

7. Corrected problem with Log Period reports integral/extension column header. 
Header should reflect correctly integral or extension in header depending on 
which equation is being used. Extension for AGA 1985 or integral for AGA 
1992 equation. 

8. Corrected problem with daily average for flow time on Log period reports. 
9. Added enhancement to allow more than 100 variables in a templates group. 
10. Corrected problem with field balance report including last partial day when 

using date range of last number of full days. 
11. Corrected problem where using Last Full Days in all reports results in the 

current date being included in the 'Effective Dates' header at the top of the 
report. 

12. Corrected problem with daily volume report where the monthly total for the 
Integral column was being calculated incorrectly.  Should have been 
averaging the integral for the month and instead was adding all the months 
integral/extension and reporting a total instead of an average. 

13. Corrected problem with outputting laptop files of meters containing a - in their 
id name to the meter id dbase. 

14. Corrected problem with viewing trend file data with WinCCU that had been 
collected locally with PCCU. 

15. Corrected problem with Accumulated Volume value being reported incorrectly 
in the file summary report. 

16. Corrected several problems with the help system not calling up the correct 
help screen associated with the function being performed. 

17. Correct problem with inability to edit long term flow data if you have previously 
gotten status from meter and output status to long term database. 

18. Added enhancements to ID manager to allow for sorting id groups when 
editing them.  

19. Added meter ID to the window title when graphing longterm or archive data 
on screen. 

20. Added next/previous button when viewing data from trend database to 
screen. 

21. Added ID to the printout of graphed archive and long term data. 
22. Increased minimum column width on reports output to spreadsheets. 
23. Corrected problem with status column not reflecting an "L" when a laptop file 

exisits on multi-tube devices. 
24. Corrected problem with scheduling functions when using the laptop files 

folder group as the id group. 
25. Corrected problem with calibration report not displaying calibration header 

when report is printed or displayed. 
26. Corrected problem with analysis entry from remote entry mode. 
27. Corrected problem when outputting log period report to excel where the log 

period data wasn't showing up in the Excel file.   



28. Corrected problem when viewing archive data from a CD. 
29. Added archive report for stream file data. 
30. Corrected problem with scheduling or manually running an alarm by 

exception with output set to printer. 
31. Corrected problem with total volume report when using last full days as date 

range including current partial day in the report. 
32. Corrected problem with canceling out of creating a configurable report 

causing WinCCU to crash. 
33. Corrected problem with viewing BTU 8000 archive data that was collected 

with WinCCU. 
34. Corrected problem with scheduling a collection using an ID group that 

contains no meters in it.  Problem caused scheduler to hang up it now will 
perform no function and exit. 

35. Corrected problem with creating an ID from a laptop file not including the 
devices location in the created ID. 

36. Corrected problems with Ascii file outputs creating wrong versions of outputs 
for packet protocol collects. 

37. Added enhancement to remote communications window to show which ID 
group is being operated on, which communications port is being used, and 
how many id in that group have been processed.  Only works if all meters in 
group were selected. 

38. Added enhancement to lengthen the path size for exporting templates to. 
39. Corrected problem where if there is no long term data in the dbase for a 

meter and then you output a status poll to the lotermdb then do a historical 
collect and outputting the collection to the lotermdb the historical collected 
data isn't getting saved to the long term database. 

40. Corrected organizational problem where a time change is done between 
midnight and the contract hour. 

41. Removed option to use single long term and trend databases. 
42. Corrected problem where outputting hand held (FS-2) data to spread sheet 

files with the initialize output file is checked but the SS file was not getting 
initialized. 

43. Corrected problem with spread sheet configuration download setup when 
WinCCU had been installed using the all users option. 

44. Corrected problem with editor when trying to insert the event use calculated 
cd. 

45. Corrected problem with sql script files not allowing the dbase to get created 
on SQL server 2005. 

46. Corrected problem with scheduler when you have multiple functions included 
in the scheduled task and try to view the setup for each of the functions 
scheduled. 

47. Corrected problem with poll for alarms not outputting to alarms to printer. 
48. Corrected problem when running a cryout update or scheduling a cryout 

update with printer selected as the output caused Winccu to crash. 
49. Corrected problem printing out trend data and the date contained a single 

digit for the year now the year appears as 2 digits on printouts. 



50. Corrected problem When in laptop or archive utilities and outputting to cfx 
files if you have the WinCCU misc. setup option set to CFX Version 5 then the 
cfx output file only contains one day in the history section no matter what date 
range is selected. 

51. Corrected problem with calibration summary report. 
52. Corrected problem with long term characteristics report. 
53. Corrected problem with graphing multiple meters data to the screen and the 

next meter/previous meter button wasn't changing the ID displayed on the 
header of the graph. lThe graphs data changed but not the id in the header. 

54. Added enhancement to add H2 and other type 4 variables to the cfx output 
file. 

55. Added enhancement to the reports and help system for Microsoft Vista OS 
compatibility. 

56. Added enhancement to allow the ability to have trend archive files. 
 
 
WinCCU Service Pack 6.04 
 
This WinCCU 6.04 product update is intended to be used with WinCCU32 6.0 or newer 
software.  Do not attempt to update an older version (WinCCU 5.28 or older) of 
WinCCU.  The program will copy the setup and associated files to your 
c:\temp\winccu604 directory (temporary directory).  If one doesn't exist the program will 
create this directory for you.  The program will automatically run setup.exe to install the 
update. 
 
Welcome to WinCCU Version 6.04.  This version includes bug fixes and enhancements 
which have been asked for from our previous version. The following are some of the 
highlights. 
 

1. Corrected problem of not being able to output configurable reports to file or 
mail. 

2. Corrected problem with calibration report when the calibration events were 
older than five years. 

3. Corrected problem with spread sheet totals output to file where only the last 
meter in a selected group would be in the file. 

4. Corrected problem where if selecting a group and continuously polling the 
station, the ID did not change as it progressed through the ID's in the group. 
Only the data and device ID were updated not the station ID. 

5. Corrected problem with scheduling a historical collection on old meters where 
if you selected anything other than 3, 10, or 35 days winccu did an auto 
collect. 

6. Corrected problem with remote entry mode. (Added updated inifiles.)   
7. Corrected problem with configurable reports not working when WinCCU is 

installed with all user option. 
8. Corrected problem with outputting standard and configurable reports 

simultaneously. 



 
WinCCU Service Pack 6.03 
 
Welcome to WinCCU Version 6.03.  This version includes bug fixes and enhancements 
which have been asked for from our previous version. The following are some of the 
highlights. 
 

1. Fixed scheduling a cryout operation that causes an application error when 
entering the path to the cryout directory  

2. Entered some changes having to do with upgrading databases.  This resulted 
from Sampson trips. 

3. Fixed Custom poll.  With output set to lotermdb, it didn't write the status to the 
long term database. 

4. Changes to group parent, filter group description, valve control meter list and 
TreeView customize no longer require restarting WinCCU to take effect. 

5. Fixed remote entry to correctly set date/time from workstation time. 
6. Fixed problem which did not allow setting paths longer than 70 characters. 
7. Fixed problem which caused winccu to hang up when PGAS File Output was 

selected during remote history. 
8. In System Setup Directory Paths, begin to browse directory location from the 

current location set in Directory. 
9. Fixed problem when using laptop file with only trend data and outputting to 

meter ids.   
10. Plunger GUI removed from WinCCU XML. 
11. Fixed problem when editing an existing schedule that has trend_collect as a 

function. 
12. Fixed problem with trend collect(auto collect option) to screen having 

garbaged header fields. 
13. Fixed problem with using a SQL database for the alarm database. Access 

worked but SQL didn't. 
14. Fixed problem where multiple workstations doing scheduled trend collects 

and the comport setup is to do tcp. If you aborted the tasks in the middle of 
their execution it causes the cpc to crash. 

15. Fixed problem with scheduling a cryout operation. 
16. Fixed problem with edits to id groups requiring a WinCCU restart before being 

applied. 
17. Fixed problem when using the Template Manager to either arrange items in a 

Group, or arrange Groups in an Area, selecting the first item (or group) and 
using the down arrow causes WinCCU to fault.  

18. Fixed problem with editing a configurable report either from Archive or Long 
Term utilities. 

19. Added enhancement so winccu setup will have a misc selection called Single 
Custom Poll Spreadsheet so when it's checked custom status polls all go to 
one file named tfcustomstatus.csv.  When not selected then the status 
spreadsheets are named after the meter id and there will be one ss per id.  



This will replace the WinCCU misc selection "Group Template Spreadsheets" 
option. 

20. Fixed problem with manually running or scheduling an alarm poll. 
21. Removed screen as an output when scheduling a trend collect. 
22. Added enhancement to create a path for CFX outouts under WinCCU setup 

directory paths. 
23. Fixed problem with date range on CFX outputs.  
24. Fixed problem with editing trend graphs. 
25. Fixed problem with DOS window staying open after a scheduled task 

completed. 
26. Fixed problem with outputting to meter ids from archive utilities when meter id 

contained a space in it. 
27. Fixed problem with adding mass to a configurable report on a selectable units 

FCU. 
28. Added enhancement to display meters processed when outputting to long 

term database from Archive a Laptop utilities. 
29. Corrected problem with scheduled items getting their parameters out of the 

registry instead of out of the scheduled tasks .ini file. 
30. Fixed problem with grid customization under winccu Setup. 

 
WinCCU Service Pack 6.02 
 
Welcome to WinCCU Version 6.02.  This version includes bug fixes and enhancements 
which have been asked for from our previous version. The following are some of the 
highlights. 
 

1. Added enhancement so that WinCCU install shows up as WinCCUXX (XX 
being version) under the control panel add/remove programs section. 

2. Corrected problem where when doing collect with output set to reports were 
creating .tmp files that were not getting deleted after the report was finished.  
Now .tmp files get deleted after process finishes. 

3. Corrected problem where collecting, viewing, and reporting did not follow the 
order in which the group was sorted when com port optimization option was 
disabled. 

4. Corrected problem where live analysis button was active in the log period 
section of FCU data even though there was no live analysis data associated 
with FCU. 

5. Added time to date range option when in trend database. 
6. Corrected problem with lock (fcuids.ldb) not getting deleted when WinCCU is 

shut down. 
7. Corrected problem of having to switch between idgroups before the status 

column on grid would get refreshed. 
8. Corrected problem with pgas outputs flowtime being incorrect. 
9. Corrected problem on trend data graph where hovering over graph and didn't 

display values.  Now trend data graphed values are displayed on the window 
title bar when you hover over a point on the trend graph. 



10. Added enhancement to allow for spaces in the name of scheduler tasks. 
11. Corrected problem with long term total volume report duplicating data on 

report when multiple meters were selected. 
12. Corrected problem with alarm by exception using wrong template if user had 

previously deleted a template from his system and then did an alarm by 
exception. 

13. Corrected problem with alarm by exception still using IDcom.dat and 
IDports.dat files.  Now Alarm by Exception uses the id database for its 
comport and comtype information. 

14. Corrected problem when not installing to the default winccu32 directory. 
15. Corrected communications problem when host com port is setup to 

communicate DDE and the CPC was configured to scan for cryout. 
16. Added enhancement to allow for double-clicking an ID on grid in order to edit 

that ID. 
17. Corrected editor problem with hourly mod codes not matching daily mod 

codes after editing daily values. 
18. Added enhancement to calibration adjustment where if you cancel WinCCU 

displays message "Changes will be lost." 
19. Corrected problem when outputting trend data to spreadsheet always 

initializing spreadsheet file even when the initialize checkbox was not 
checked. 

20. Corrected problem of scheduler hanging up when a trend collect was 
scheduled on an empty id group. 

21. Corrected problem of long term database not displaying the selectable units 
for selectable units flow computers. 

22. Corrected issues with installing for all users when previously installed under 
current user. 

23. Added enhancement to allow for multiple access trend databases. 
 
WinCCU Service Pack 6.01 
 
Welcome to WinCCU Version 6.01.  This version includes bug fixes and enhancements 
which have been asked for from our previous version. The following are some of the 
highlights. 
 

1. Corrected issue of not being able to build a user account with administrator 
privileges. 

2. Corrected issue where WinCCU was unable to create a sql ID database. 
3. Corrected issue of getting an unhandled exception error when performing a 

customize under setup dropdown.   
4. Enhanced performance when switching between id groups when using a 

large id database. 
5. Corrected issue where remote communications would not perform multiport 

communications when manually collecting. 
6. Suppressed error message in scheduled operations when WinCCU is unable 

to access cpc mailbox, thus allowing scheduled task to proceed. 



7. Added enhancement to refresh treeview and grid when adding ids or new id 
group. 

8. Corrected issue where scheduled tasks were not closing the batch file after 
running. 

9. Corrected issue with multiple trend collects. 
10. Corrected issue with remote entry when multiple meter are configured. 
11. Corrected issue with automatic option under trend collect. 
12. Corrected graphical editing issues. 
13. Corrected issue with resetting Canadian events. 

 
WinCCU Service Pack 6.0 
 
New Features: 

1. New Shell (user interface) 
2. New Active Reports Package 
3. New Scheduler Operations(employs microsoft scheduler) 
4. Register Based Remote Configuration  

 
Attention: 
If you are upgrading from WinCCU4.xx or older and you are having problems remotely 
communicating to your units it may be necessary to enter id manager and verify that all 
of your com types are setup for a parity of none.  If any of your com types are set to odd 
or even parity change them to none.  The default parity for Totalflow communications is 
a parity of none. 
 
Introduction 
 
The TOTALFLOW Windows Central Collection Unit (WinCCU) is a set of functions 
integrated into a single windows program used to collect, process and report data 
generated by TOTALFLOW Flow Computer Units (FCU), Remote Terminal Units (RTU) 
or Analyzer Interface Units (AIU).  WinCCU is a prominent part of the TOTALFLOW Gas 
Measurement System for several reasons: 
  

• Allowing for several different data collection methods (PCCU, MCU Radio, 
Modem, and RS485. 

• Bridging the gap between the field and the home office by acting as a front 
end processor to allow only the necessary data to be send downstream. 

• Storing large amounts of device data for reporting and auditing needs. 
• Providing field personnel with quick access to flow data to aid in field 

problem detection. 
• Maintaining a complete audit trail of parameter changes in the FCU as 

well as changes to the flow data from WinCCU. 
• Generating data for input to a gas accounting system. 
• Providing control and field monitoring functions in connection with 

TOTALFLOW RTUs. 



• Providing an extensive and extensible report system based on an industry 
standard database. 

 
System Requirements: 
 

• Microprocessor:  Pentium 
• Memory:   128 MB 
• Hard disk space:  50 MB available for Winccu32 
• Disk drive:   CD ROM drive 
• Video adapter:  VGA or higher resolution 
• Pointing device:  Microsoft Mouse or compatible pointing device 
• Operating System: Windows 2000 or later 

 
Installing the WinCCU software from the CD ROM 
 
IMPORTANT: Close all programs except for Windows when installing software. 
 

1. Insert the CD in the CD ROM drive. 
2. The Install Program should automatically load. (Assuming the 'Auto Insert 

Notification' has not been turned off). 
3. If the Install Program does not automatically load, click on 'Start' then 'Run'. 
4. Type the CD drive letter plus "setup", .e.g. (E:\disk1\setup) 
5. Click 'OK'. 
6. The Install Program will be loaded followed by a 'Welcome Message'. 
7. Click 'Next'. 
8. Enter your name and your company name. 
9. Click 'Next'. 
10. Change the Destination Directory if desired but leave the other options at 

default. 
11. Click 'Next'. 
12. Change the Program Folder if desired. 
13. Click 'Next'. 
14. The installation process will load all the required software. 
15. If the install program asks you to restart the computer, please do so before 

running the WinCCU software. 
16. If you have no message to restart the computer but the screen is displayed 

for Reading the Readme file or running WinCCU now. The installation is 
complete. 

17. Check or un-check a selection and click 'Finish'. 
 
If you find any problems, contact ABB, otherwise, exit the program. 
 
Configuring software settings after installation 
 
 



• Open the WinCCU program group and double click on the WinCCU icon.  This 
will bring up the WinCCU shell.  Place the mouse pointer for a second on each 
toolbar button one at a time (without pressing the mouse button).  When you do 
this, the program will display a "toolbar tip" that describes the function of each 
button.  These buttons provide a shortcut to most of the WinCCU.  You can also 
use the menu selections to start the WinCCU functions.  Select the Help menu 
option and then Contents.  Go Through the section on installation.From the 
WinCCU menu, select Setup, then WinCCU System Setup and the following 
tabbed window appears, allowing you to setup most necessary parameters from 
one place. When you install the WinCCU, a directory tree is automatically built 
under the main installation directory that you specified.  By leaving these as is, 
(recommended) you will keep your WinCCU files separate from your other 
software, including the DOS CCU files.  Next, go to the Comm Types tab and 
setup any remote communication types you need to use for collecting data, etc.   

 
• Next, go to the Comm Ports tab and setup each Comm Port used.  You can 

communicate through WinCPCs on many machines, but most will just be using 
the one on the same machine that they run their WinCCU on.  If you are using a 
WinCPC on the same machine as the WinCCU, just assign a Port name and 
check the 'Use" box, assign the physical comm port # and check the DDE box.  If 
you are talking to a WinCPC on another machine over a network, you might want 
to use a file to communicate to the WinCPC instead of DDE.  In that case, just 
assign a Port name, check the 'Use" box, assign the physical comm port #, clear 
DDE box and assign a pathname where the WinCPC will be looking for requests.  
Remember, that the path that you assign to a given port must be entered in the 
WinCPC setup screen as the server path. 

 
• Go to the WinCCU program group and double click the WinCPC icon.  Under the 

Setup file option, select the setup option again.  Enter a Comm Server Pathname 
that matches the necessary entries in the WinCCU Setup screen under Comm 
Ports. 

 
Importing DOS CCU data into the WinCCU 
 
 

• Click on the ID Manager button in the toolbar. Import your DOS Meter ID 
file into the WinCCU format.  This is done by selecting the File menu 
option, then Import DOS ID Definitions. Search for the directory where 
your DOS fcuids.dat file is located and press OK. When you have finished, 
close the ID Manager window by pressing the Close button. 

 
• Click on the Archive Reporter toolbar button. Import your DOS CCU 

TFDATA file into the WinCCU format.  (The WinCCU stores the archive 
data as individual binary data files (by meter).  This is done by selecting 
the File menu option, then Import TFDATA.  Search for the directory 



where your DOS TFDATA file resides and press OK. When you have 
finished, close the Archive Reporter window. 

 
We appreciate your choice of Totalflow and want to make this software the best it can 
be in meeting your operational needs.  We would like to hear from you if you have any 
comments or problems.  You can contact us at the following address. 
 
   ABB Inc. 

Totalflow Products 
Customer Service 

   7051 Industrial Blvd. 
   Bartlesville, OK  74006 
 
   or phone 1-800-442-3097 
 


